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Buy Low, Sell High

Subjects: Economics, Math, Language Arts
Required Software: Microsoft® Word, Microsoft® Excel
Optional Software: Microsoft® Internet Explorer, Microsoft® Works

P Teaching Guide
P Student Activity

Teaching Guide

Summary

This lesson will teach students how to invest in corporate stocks by
creating investment "portfolios." Step-by-step instructions will enable
students to develop worksheets that track their portfolio's performance
over a specified time period and report the results to the class.
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Lﬁymbn] ACME Initial Investment: $207.50
E=E Exchange: NASDAQ

1
e INITIAL INVESTMENT

& |Date of Transaction $/Share # Shares Total Investimant

R a7 20,75 10 $207.50
5 :

g DML\" RECORD

Currant

10 :Dﬂ'tE of Transaction |[# Shares $/Share Value Profitl.ozs

11 0F 97 10 2075 520780 $0.00
12 QT 100 2025 $302.50 -35.00
13032197 10 1979 $197.80 -510.00
14 ey 0 M.13 §241.2% $3.75
16 032307 10 2125 521281 $5.00
B | (32497 10 2228 §222.8) $15.00
17 0E2a0eT 10 2225 §22281 51500
A8 QM7 100 M.75 $217.5) §10.00
1900572757 10 21.B3 $XMB2 $3.75
MO PAF 10 2225 §2228) £15.00
20320407 10 2178 FM7ED §10.00
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Stock portfolio worksheet created in Microsoft Excel
Objectives

To introduce students to the stock market, design a worksheet that
calculates profit (or loss) for any given investment, and generate line
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graphs representing stock performance

Prerequisite Skills

Knows Microsoft Excel basics and its many features including creating
worksheets and charting, how to create an electronic slide presentation
using Microsoft® PowerPoint®, how to access the World Wide Web using
Microsoft Internet Explorer (optional)

Time Alloted
Approximately six weeks to three months

How to Begin

Introduce students to the Stock Market summarizing its role in U.S.
economic history (e.g., the great crash of 1929). Define terms that
students are likely to encounter in their research such as portfolio,
dividend, and price/earnings ratio (i.e. stock price divided by stock earnings
per share.) Have students bring in the business section of newspapers that
publish stock market information and explain to them how to read a stock
guote. Have each student choose five companies whose stock they want
to purchase. Explain that everyone in the class will start with $1,500 as
seed money to purchase stocks at the current market value and that they
will track their portfolio's performance over a period of time from six weeks
to three months. Finally, discuss with students the effectiveness of line
charts in presenting their results.

Extension Activities
Have students consider trading their stock (buying or selling shares)
during the specified time period.

Have students create a Summary worksheet of their investments.
Columns should contain cells that reference initial investments, total
shares owned, current price/share, and profit/loss figures for every
company in the portfolio.

Student Activity

Description
In this activity, you will invest $1,500 in five different companies and then
track the stock market price of those companies over a period of time.

sTEP 1 Researching the Market
SOFTWARE: Microsoft Encarta, Internet Explorer

WHAT TO DO: Choose ten companies in which you think you would like
to invest. Using Microsoft's Internet Explorer and a search engine such as
Lycos or Yahoo, access each company's Web site in order to gather as
much background information as possible about each company, including:

Type of company

Number of years in business
Summary of what the company does
1996 profits

1997 profits (thus far)
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* Now, review the information gathered and decide on five
companies in which to invest. Find out the current selling price per
share for each company's stock. Decide how many shares of stock
you want to buy in each company keeping in mind that you have
only $1,500 to invest.

TIP! Encarta 97 includes several helpful articles about the stock market.
Use the encyclopedia's Find command to search for keywords such as
"Stocks and Bonds," "Finance," and "Stock Exchange."

TIP! Using Internet Explorer, visit a Web site called "Investing for Kids" or
"StockMaster," the stock market site referenced in the Web Links section
of Encarta. Or, you can access a wealth of business news and financial
information to track the performance of selected stocks by visiting the
Web site of "Microsoft Investor."

B Investing For Kids - Microsoft Inteaned Euploes

for Koy welcomes you! This Web site is designed by kids for ldds. 1t examines sincks, honds, stk
funde and the like, Ii alss teaches kids and adulis ihe principles of saving and investing,

20836

Simoe August 15, 1996, we ko had visiinrs. [ Textonly]

Welcome te ThinkCuest  Check out our $nvesting for KidS  We wish

Finaneind Chaix A Stack Porifolin
o {Afe vau s beginner or .. 7 {Ues in economics clasies)
S Begmner Goal Calcalator

Example 1: "Investing for Kids" web site (from Internet Explorer)
Recommended Web Sites
¢ Investing for Kids

e StockMaster
¢ Microsoft Investor

STEP 2 Creating a Spreadsheet

SOFTWARE: Microsoft Excel, Microsoft Word

WHAT TO DO: Open Microsoft Excel. Add 2 new worksheets to your
workbook so you have a worksheet for each of the five companies in your

investment portfolio.

TIP! Adding worksheets is easy. Simply click Worksheet from the Insert
menu. Use the Office Assistant to learn how to rename a worksheet.

For each company's worksheet, you will input (a) some basic information
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about the company, such as the company Symbol (the unique symbol
assigned to a NASDAQ security) and the name of the particular Stock
Exchange that lists the stock; (b) an Initial Investment section; and (c) a
Daily Record section.

AG4E =1 =]

= A j| =] D | E |
BE ACMEDIATE CORPORATION
(3 |symbel: ACME Initial Investment: $207 50
4 |Ewchange: NASDAQ

5
(B |INITIAL INVESTMENT
7| Date of Transaclion $Share  # Shares Total Investrmenl
- 5 FIN95r 075 10 L0750
10| DAILY RECORD

Currani

A1 Date of Transaction # Shares | $Share Value ProfitLoss
2 3197 10 2075 sA7S0 0.0
3l 3207 10 2025 X250 2500
14 032197 10 18,75 $197.50 -£10,00
15 0322457 10 2193 21175 5378
16 Q32357 10 21.25 $212.50 $5.00
AT 324457 10 7MW 52240 §16.00
8 3257 0 ;! §72AD £15.00
13 032697 ili] NI 82750 £10.00
20 03277 10 253 $216.25 875
il OB28/E7 10 7235 §27250 §15.00
22 Q32057 10 2175 $217.50 $10.00
23 OEras? 10 2213 Ly $13.75
“hd

Example 2: Stock Portfolio worksheet created in Microsoft Excel

Here are some step-by-step instructions to get you started with your
worksheets:

¢ In cell Al, type the company name, for example, ACMEDIATE
Corporation

¢ Highlight A1:E1; then click Merge and Center on the Formatting
Toolbar to center the company name.

¢ In cell A3, type "symbol:" followed by the company's four-letter
symbol, for example, ACME; in cell E3, type "itial Investment" followed
by the total amount of money (number of shares times the price per
share) you are investing in that company. Your total investment
equals the total price paid for the stock.

¢ In cell A4, type "Exchange:" followed by the name of the exchange
listing the stock.

TIP! To enlarge a cell, point to the column border, the cursor will change
to a two-headed arrow. Now, drag the column to the desired width.

TIP! Format all currency for two decimal places by choosing Cells under

the Format menu, clicking the Number tab, and then selecting Currency
under Categories. In the Decimals places enter the number 2.

STEP 3 Invest in your Companies

SOFTWARE: Microsoft Excel

WHAT TO DO: To create the Initial Investment section of your
worksheets, try these tips:

¢ In cell A6, type "Initial Investment" and change to bold face type.
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In cell A7, type "Date of Transaction."
In cell C7, type "$/Share";
in D7, "# of Shares Bought"; in E7, "Total Investment".

Right click the highlighted cells, then choose Format cells.
Click Alignment, select Center.
In cell A8, type the date of the initial transaction

Format Cells |

e Highlight A7:E7
L[]
(]

! Aligriment I Fank I Border i Patterns i Praotection i
Cateqory: ~Sample ;
zeneral __j +0.00 |
hurnber
CUrrency Diecimal places: |2 5‘
Accounting
Date Swrnbol:

Time & -vj
Fercentags Megative numbers:

Frackion HE0 ‘

Scientific ]

Text £1.234.10

Special (41,234,100

Cuistom i1 2341m

Currency Formats are used For general maonetary values, Use Accounting
fFormats to align decimal points in a column,

| Ik i Zancel

Example 4: Format Cells dailog box

TIP! At this point you may want make four copies of the worksheet to use
as a template for each company's stock that you track. Select Move or
Copy Sheet from the Edit menu, click the Create a Copy check box, then
repeat this procedure for as many copies as you need.

¢ In cell C8, type the cost per share (e.g., 20 3/4) as listed on the
stock exchange. Microsoft Excel will automatically convert this
figure to decimals. Be sure to format the number for two decimal

places.

¢ In cell D8, type the number of shares bought. In cell E8, type the
formula: =c8*D8 and press enter. The total cost of your investment
will automatically be calculated. Format to two decimals places.

STEP 4 The Daily Record Section

SOFTWARE: Microsoft Excel

WHAT TO DO: To create The Daily Record section of the worksheet,

follow these steps

¢ In cell A9, type "Daily Record."

]

In cell A10, type "Date of Transaction"; in B10, "#/Shares"; in C10,

"$/Share"; in D10, "Current Value"; in E10, "Profit/Loss".

]

Highlight A10:E10 and center and wrap text.

¢ Beginning with cell A11, highlight the range of data in Column A
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you will be entering on your worksheet, for example , A11:A22.
Right click the highlighted cells. Choose Format Cells. Click the
Number tab. Click Date, then choose Type of Date. Click OK.

¢ In cell B11, type the number of shares bought. Ask the Office
Assistant "How do | fill down?"

¢ In cell C11, record the price of your stock on the first date of
transaction.

¢ In cell D11, type the formula: =B12*C12.

¢ In cell E11, create a formula that calculates Profit/Loss by taking
the Current Value (D12) minus the initial investment (E8). The
formula should refer to D8 as an absolute reference- =D12-$E$8.

2 Microsofl Excel - ACMEDIATE CORPORATION WDORKBDOK
Bk Ede ew Inset Pomat Jocls Daks indow Heb
[DeRleRy s n@ET|o- - @& = & 22|09z

[} e o EBrUEEEE|S %, B8 EE]
£l =| =| =D11-3E47
Sl | s e e L E =
1 ACMEDIATE CORPORATION |
[ 2" |Symbal: ACME Initial Investment: $207 50
=i Exchange: NASDAG
4
i INITIAL INVESTMENT
6 |Date of Transaction %/Share # Shares Total Investment
7 3Mear 2075 10 F207 .50
g
9 |D&ILY RECORD
Current
10 | Date of Transaction  # Shares $/Share MWalue ProfibLoss
| Darieay 1M 2075
T | 0T 0 2025
A3 | 0T 0 1975
14| (2297 m 2143
15 | 2397 m 2125
16 | 0248007 L
17 | 0 2E97 0 2335
18 |0 2EaT m 2175
19| R TAT 0, 2ME3
20| 032897 m 223
2| oarear m - 2175
2F |0 3aF 0 2113
73

Example 5: Highlighted data to create Microsoft Excel chart

TIP! Look up "cell references" in Office Assistant to learn more about this
term. Ask the Office Assistant how to format Column E for currency.

STEPS Tracking Stocks
SOFTWARE: Microsoft Excel

WHAT TO DO: At the end of the stock performance period, use the Chart
Wizard in Microsoft Excel to create a line chart showing "profit or loss" for
each stock you invested in.

Highlight the range of data you've entered on your worksheet, for
example, E12:E23 . Click Chart from the Insert menu, then choose Line
and step through the procedures for creating a line chart. Be sure to add a
chart title. Label the chart's X and Y axes.
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Example 6: Line Chart created in Microsoft Excel showing profit/loss

Why does the line chart do a better job of representing the stock data than
a pie chart? For more help, ask the Office Assistant about "charting."
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